
Chapter 5

Datums

After completing this chapter, you will be able to:
• Understand three default datum planes.
• Understand selection methods in Pro/ENGINEER Wildfire 4.0.
• Create datum planes using different constraints.
• Create datum planes on-the-fly.
• Create datum axes using different constraints.
• Create datum points.
• Create extrude and revolve cuts.

Learning Objectives
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DATUMS
Datums are imaginary features with no mass or volume. Datums are available to help you
in creating models. They act as reference for sketching a feature, orienting the model,
assembling components, and so on. Remember that the datums play a very important role
in creating complex models in Pro/ENGINEER and therefore you must have a good
understanding of datums. Datums are considered to be features but not model geometry.
In Pro/ENGINEER, datums exist as datum plane, datum curve, datum point, datum coordinate
system, datum graph, and so on.

Default Datum Planes
When you enter the Part mode or the Assembly mode, the three datum
planes are displayed by default in the drawing area. These datum planes
are known as the default datum planes and they are mutually
perpendicular to each other. The only difference between the default
datum planes of the Part mode and those of the Assembly mode lies in
the names of the datum planes.

The default datum planes in the Part mode are named as FRONT, TOP,
and RIGHT. In case of the Assembly mode, the default datum planes are
named as ASM_FRONT, ASM_TOP, and ASM_RIGHT. However, the
names of the default datum planes can be changed if required.

To change the names, choose Edit > Setup from the menu bar. The
Menu Manager with the PART SETUP menu will be displayed, as shown
in Figure 5-1. Choose the Name option from this menu; you are prompted
to select a feature to change the name. Select the datum plane you want
to rename. When the Message Input Window appears at the top of the
drawing window, enter the desired name in it and choose the Accept
value button.

The PART SETUP menu can also be used to set the material, units, and other parameters
related to the model.

Note
The default unit of a part is Inch lbm Second. The length is measured in inches, mass in lbm,
time in seconds, and temperature in Fahrenheit. There are other systems of units that are avail-
able and you can change the units as desired.

NEED FOR DATUMS IN MODELING
Generally, most of the engineering components or designs consist of more than one feature.
First the base feature of the model is created and then other features of the model are added.
Since all features of a model cannot be drawn on a single plane, therefore, to draw rest of the
features, sometimes, additional planes have to be created or selected. Also, most of the times,
the three default datum planes are not enough to create a complex model having many
features. For example, Figure 5-2 shows a simple model that consists of two features that
require two different planes.

Figure 5-1  The
Menu Manager
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considered as the base feature. However, in this discussion, the feature that is selected as the
base feature is shown in Figure 5-3. After creating the base feature, the next feature will be
created. For the next feature, a sketching plane has to be defined. Therefore, an additional
plane has been created on which you can draw the sketch for the second feature.

As shown in Figure 5-4, the plane that is used to create the base feature is highlighted by a
mesh. To create the second feature, a new plane is created which is shown in Figure 5-5. The
sketch of the second feature is drawn on this plane.

Note
Throughout the book, at some instances the datum planes are shown by a mesh plane as is evident
from Figure 5-4. This view of the datum plane is only for explanation. In Pro/ENGINEER, when
you create a datum plane, they do not appear in the form of mesh.

To create various types of datums, you need to select the references on the model. Based on
the selection you make on the model, Pro/ENGINEER applies constraints to create the datum.

Selection Method in Pro/ENGINEER Wildfire 4.0
The selection method in Pro/ENGINEER Wildfire 4.0 is divided into two types:

1. Selection
2. Collection

Figure 5-3  Base feature of the modelFigure 5-2  Model having two extruded features

Tip: Whenever you come across any solid model, first try to visualize the number of
features in that model and then decide which feature is to be considered as the base
feature.
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Figure 5-5  Plane selected for the second featureFigure 5-4  Plane selected for the base feature

Selection
In Pro/ENGINEER Wildfire 4.0, selection refers to the action in which you first select the
entities like edge, plane, face, axis, coordinate system, and so on, and then invoke a feature
creation tool. This property of a design package is also known as Object Action. To make
your selection process easier, filters are available in Pro/ENGINEER Wildfire 4.0. Filters are
the options that are available in the Filter drop-down list located at the lower right corner of
the main window in the Status Bar. The options in the Filter
drop-down list change with the mode that is active. The options in
this drop-down list when you are in the Part mode are shown in
Figure 5-6.

As you select the entities on the model, the number of selected
entities appear to the left of the Filter drop-down list in the Status
Bar. When you double-click on the number, the Selected Items
dialog box will be displayed, as shown in Figure 5-7. All selections
that you make on the model are available in this dialog box. You
can use the dialog box to remove the selected entities. These
selections appear highlighted in red color on the model. To remove
a selection on the model, press the CTRL key and then select the
entity in red.

By default, the Smart filter is selected in the Filter drop-down list. The second filter in the
Filter drop-down list is Features. This filter is used to select the features on the model. To

Figure 5-7  The Selected
Items dialog box

Figure 5-6  The Filter drop-down list
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redefine a feature, select this option from the drop-down list. The third filter is Geometry.
This filter allows you to select only the edges, vertices, and surfaces. The fourth filter is
Datums. This filter allows you to select the datum features. The fifth filter is Quilts. This
filter allows you to select surfaces. The sixth filter is Annotation. This filter is used to select
the notes from the drawing area.

Collection
In Pro/ENGINEER Wildfire 4.0, collection refers to the action when you have invoked a
feature creation tool and then select the entities to collect the references in order to create
that feature. To make your selection process easy, filters can be used. The filters available in
the Filter drop-down list depend on the feature creation tool that you have invoked.

DATUM OPTIONS
After discussing the default datum planes, which are the first feature in the Part mode, you
must know the various other features created using the datum options. Datums are also
considered as features having no geometry. Figure 5-8 shows the Datum toolbar and
Figure 5-9 shows the method of invoking various types of datum options from the menu bar.

Datum Planes
You can create datum planes, other than the three default datum planes, by using the
menu bar or the Datum toolbar. The datum planes can be created anytime when
required. The display of the datum planes can be turned on or off by using the Plane

Display button from the Datum Display toolbar. Before discussing the procedure to create
datum planes by using the available options, it is important to understand the use of datum
planes. Some of the uses of datum planes in Pro/ENGINEER Wildfire 4.0 are listed below:

1. Datum planes are used as sketching planes to create sketches for the features of a model.

2. Datum planes are used as reference planes for sketching.

3. Datum planes are used as references for placing holes and for assembly.

4. Datum planes are used as a reference for mirroring features, copying features, creating
a cross-section, and for orientation of references.

Figure 5-8  The Datum toolbar
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Pro/ENGINEER provides you with various constraints to create additional datum planes.
Additional datum planes are created with the help of constraints and the filters available in
the Filter drop-down list. Datums can also be created while you are in the sketcher environment.
When you choose Insert > Model Datum > Plane from the menu bar or Plane button from
the Datum toolbar, the DATUM PLANE dialog box will be displayed, as shown in
Figure 5-10. Separate buttons for creating datum axis, datum curve, datum point, datum
coordinate system are available in the Datum toolbar.

Figure 5-10 shows various options available in the DATUM PLANE dialog box to create
datum planes. The options available in different tabs of the DATUM PLANE dialog box are
discussed next.

Placement Tab
The Placement tab in the DATUM PLANE dialog box is chosen by default. Under this

Tip: Generally, for the base feature creation, the three default datum planes are used
and as the part becomes complex or in other words, as the number of features increase,
the need for additional datum planes arises.

Figure 5-9  Invoking the datum options from the Insert menu in the menu bar
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tab, the References area displays the references that are selected to create the datum
plane. The constraints are displayed on the right of the references. These constraints
are applied automatically based on the reference you select. To change a constraint,
select the constraint in the dialog box; you will notice that a drop-down list appears in
its place. From this drop-down list, select a different constraint. This drop-down list is
available only for those constraints in the dialog box, which can be substituted by
another constraint. The constraints that are used to create a datum plane are discussed
later in the chapter.

The Offset area is available only when the Offset constraint is used to create a datum
plane. The Rotation edit box is used to enter the rotation angle of the new datum plane.
The angle can also be set dynamically on the model by using the drag handle displayed
on the model.

Display Tab
The Display tab of the DATUM PLANE dialog box is shown in Figure 5-11. The Flip button
in this dialog box is used to change the normal direction of the datum plane being created.
Every datum plane has two sides, one is colored brown and the other is black. These colors
are visible when the plane is rotated such that its back side comes into view. By default, the
arrow on the plane points toward the brown side. The arrow direction and hence the
direction of the plane can be changed by using the Flip button.

By default, the Adjust Outline check box is clear. If you select this check box, it allow you to
set the size of the datum plane.

Properties Tab
The DATUM PLANE dialog box with the Properties tab chosen is shown in Figure 5-12.
This tab when selected, allows you to name the datum plane you are creating. By default, the
first datum plane you create is named DTM1 and then every datum plane created is successively
numbered.

Figure 5-10  The DATUM PLANE
dialog box with the Placement tab chosen
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When you create a datum plane, the constraints are applied automatically based on the
selection you make on the model. These constraints appear in the DATUM PLANE dialog
box. Sometimes, while applying constraints to define a datum plane, a single constraint is
enough to define the datum plane and sometimes, you may need more than one constraint
to do the same. When only one constraint is used to create a datum plane, it is called stand-alone
constraint. The stand-alone constraints are sufficient by themselves to constrain a datum
plane definition. The constraints that are used to create a datum plane are discussed next.

Through Constraint
The Through constraint is used to create a datum plane through any specified axis, edge,
curve, point/vertex, plane, cylinder, or coordinate system. This constraint can be used in
combination with other constraints that are discussed next.

However, the Through constraint can also be used as a stand-alone constraint when you
select a plane. Figure 5-13 shows the datum plane constraint combinations using the Through
constraint. Datum planes can be created using any of the combinations shown in the figure.
The possible combinations of datum plane creation are referred to as Yes and the combinations
that are not possible are referred to as No in the figure.

While reading the table shown in Figure 5-13, first preference is given to the text written in
the first column and then the text in the first row should be read. For example, if you want to
make a datum plane that is passing through a cylinder and normal to a plane then look for
Through in the first column and then for Cylinder in the second column. Now, look for
Normal in the first row and for Plane in the second row. After finding both the
combinations trace them in the respective column and row till they intersect. You
will find Yes. This suggests that the creation of a datum plane that passes through a cylinder
and is normal to a plane is possible. While reading the table shown in Figure 5-13, remember
that the constraints that are not stand-alone have to be applied in pairs.

Figure 5-11  The DATUM PLANE
dialog box with the Display tab chosen

Figure 5-12  The DATUM PLANE
dialog box with the Properties tab chosen
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The options in the Filter drop-down list shown in
Figure 5-14 are used to make selection on the model. This
drop-down list is located at the bottom right corner of the
main window. The options in this drop-down list change
depending on the operation being performed. For example,
when you are creating a datum plane, the options shown
in Figure 5-14 are available. Once you exit the datum plane
creation, the options in this drop-down list change.

Figures 5-15 and 5-16 show the cylindrical surface and
the default datum plane used to create a datum plane at an
angle to the selected default datum plane and passing
through the center of the cylindrical surface. When you select
the cylindrical surface, it is highlighted in red, indicating
that it is selected. To make the second selection, select the
Datum Plane filter from the Filter drop-down list. Now,
press the CTRL button and then select the datum plane.
This method of selecting by pressing the CTRL button is
known as collection. Click on the constraint displayed against the selected plane in the DATUM
PLANE dialog box and select the Offset option from the drop-down list. Enter the angle
value in the Rotation dimension box. Choose the OK button to create the datum plane.

Note
The first reference to constrain a datum plane is selected using the left mouse button. The second
reference is selected using the CTRL+left mouse button.

Make sure you change the option in the Filter drop-down list when you invoke any other tool.

Figure 5-13  Datum plane constraint combinations using the Through constraint

Figure 5-14  The Filter drop-down
list with options
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Figure 5-17  Datum plane constraint combinations using the Normal constraint

Figure 5-16  Resulting datum plane passing
through the center of a cylinder

Figure 5-15  Selecting a cylindrical surface and a
default datum plane to create a datum plane

Normal Constraint
The Normal constraint is used to create a datum plane normal to any specified axis, edge,
curve, or plane. This constraint is used in combination with other constraints. The Normal
constraint cannot be used as a stand-alone constraint. Figure 5-17 shows the datum plane
constraint combinations using the Normal constraint.

The possible combinations of datum plane creation are referred to as Yes and the combinations
that are not possible are referred to as No.

Figure 5-18 shows a planar face and a cylindrical face of a solid model. The planar face is
selected as the normal surface and the cylindrical face is selected to be tangent to the datum
plane. The following steps explain the procedure to create this datum plane:

1. Invoke the DATUM PLANE dialog box. Select the first reference shown in Figure 5-18.
The Offset constraint is automatically applied and will be displayed in the References
collector.
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2. Left-click on the Offset constraint in the collector; a drop-down list appears. Select the
Normal constraint from this drop-down list.

3. Now, use CTRL+left mouse button to select the second reference shown in Figure 5-18.
The Through constraint will be displayed in the References collector.

4. Change this constraint to Tangent from the drop-down list that appears when you click
on the constraint in the References collector. The datum plane that is created is shown
in Figure 5-19.

5. Choose the OK button from the DATUM PLANE dialog box.

Parallel Constraint
The Parallel constraint is used to create a datum plane parallel to any specified datum plane
or planar face. This option is used in combination with other constraints. The Parallel
constraint cannot be used as a stand-alone constraint. Figure 5-20 shows various datum
plane constraint combinations using the Parallel constraint. The possible combinations of
datum plane creation are referred to as Yes and the combinations that are not possible are
referred to as No in Figure 5-20.

Figure 5-21 shows the selection of a default datum plane and an axis to create a datum plane.
The resulting datum plane is parallel to the selected datum plane and passes through the
axis, as shown in Figure 5-22. The steps explaining the procedure to create this datum plane
are given next:

1. Invoke the DATUM PLANE dialog box. Select the first reference shown in Figure 5-21.
The Offset constraint is automatically applied and will be displayed in the References
collector.

2. Left-click on the Offset constraint in the collector; a drop-down list appears. Select the
Parallel constraint from this drop-down list

Figure 5-19  Resulting datum planeFigure 5-18  Selecting a planar surface and a
cylindrical surface to create a datum plane
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Figure 5-22  Resulting datum planeFigure 5-21  Selecting a datum plane and an axis
to create a datum plane

3. Now, use CTRL+left mouse button to select the second reference shown in Figure 5-21.
The Through constraint will be displayed in the References collector.

4. Choose the OK button from the DATUM PLANE dialog box. The datum plane that is
created is shown in Figure 5-22.

Offset Constraint
The Offset constraint is used to create a datum plane at an offset distance to any specified
plane or coordinate system. This option is used in combination with other constraints. However,
the Offset constraint can be used as a stand-alone constraint when you select a plane to offset
from.

When the Offset constraint is applied, the Translation dimension box appears in the
DATUM PLANE dialog box. This dimension box list is used to specify an offset distance. In
the case of angular planes the Translation dimension box  changes to the Rotation
dimension box in which you need to specify the angle. An arrow appears on the model that
shows the positive direction of the offset distance or angle.

Figure 5-20  Datum plane constraint combinations using the Parallel constraint
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Figure 5-23  Datum plane constraint combinations using the Offset constraint

Figure 5-23 shows various datum plane constraint combinations using the Offset constraint.
The possible combinations of datum plane creation are referred to as Yes and the combinations
that are not possible are referred to as No in the Figure 5-23.

Figure 5-24 shows the selection of a default datum plane and an edge to define an offset
datum plane. The resulting datum plane is at an offset to the selected datum plane and
passes through the edge, as shown in Figure 5-25. The following steps explain the procedure
to create this datum plane:

1. Invoke the DATUM PLANE dialog box. Select the first reference shown in Figure 5-24.
The Offset constraint is automatically applied and will be displayed in the References
collector. The Translation dimension box appears.

2. Now, use CTRL+left mouse button to select the second reference, which is a vertex
shown in Figure 5-24. The Through constraint will be displayed in the References
collector.

3. Choose the OK button from the DATUM PLANE dialog box. The datum plane that is
created is shown Figure 5-25.

Note
The OK button in the DATUM PLANE dialog box is enabled only when the datum plane you
are creating is fully constrained.

Tangent Constraint
The Tangent constraint creates datum planes tangent to cylindrical features. This constraint
is also used with other constraints to create various types of datum planes. Figure 5-26 shows
the datum plane constraint combinations using the Tangent constraint. The possible
combinations of datum plane creation are referred to as Yes and the combinations that are
not possible are referred to as No in the figure.
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Figure 5-26  Datum plane constraint combinations using the Tangent constraint

Note
To remove a selected reference, select the reference in the dialog box and press DELETE.

Datum Planes Created On-The-Fly
The term On-the-Fly refers to the creation of a datum plane when the system prompts
you to select or create a plane. At this step, if you choose the Plane button from the
Datum toolbar, the datum plane created will be called datum plane on-the-fly. When
you create a datum plane on-the-fly, the datum plane is neither visible in the drawing
area nor will be displayed under the default display of the Model Tree once the feature
is completed.

You can try making a datum plane on-the-fly by following these steps:

1. Choose the Extrude button; the Extrude dashboard will be displayed.

Figure 5-25  Resulting datum planeFigure 5-24  Selecting a datum plane and an edge
to create a datum plane
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2. In the Extrude dashboard, choose the Placement tab and then choose the Define button to
invoke the Sketch dialog box.

3. Now, you need to select a sketching plane. You can select an existing datum plane, a face
as the sketch plane, or you can create a datum plane on-the-fly.

4. Choose the Plane button from the Datum toolbar. Select the references and constraints
to create the datum plane. This datum plane when created is automatically selected as
the sketching plane.

When you need to select the references to orient the sketching plane, at this step also you can
create a datum plane on-the-fly. Once the datum plane on-the-fly is  created, it cannot be
referenced by other features.

The datum plane created on-the-fly does not appear in the Model Tree under the default
display. But it can be seen in the Model Tree when you click the plus sign (+) that appears to
the left of the feature you have created. The datum plane and the feature that you have
created are grouped and appears as a grouped feature in the Model Tree. This means that
the datum on-the-fly that was created during feature creation belongs to the feature that is
created.

Note
Unlike the previous releases of Pro/ENGINEER, now you can create a rotational pattern
without creating a datum on-the-fly.

Datum Axes
Datum axis is an imaginary axis that is created in Pro/ENGINEER to help you in
creating a model. Datum axes can be created manually. They are also created
automatically when any cylindrical feature is created. The display of the datum axis

can be turned on or off by using the Plane Display button from the Datum Display toolbar.
The uses of datum axes are given next.

1. Datum axes act as reference for feature creation.

2. They are used in creating a datum plane along with different constraint combinations.

3. They are used in placing features co-axially.

4. They are also used to create rotational patterns. You will learn to create patterns in
Chapter 7.

Note
You can also create a datum axis perpendicular to the sketch plane in the sketcher environment.
To create a datum axis in the sketcher environment, choose Sketch > Axis Point from the menu
bar. Then, select a point in the drawing area through which the axis will pass.

Datum axes are named by default in Pro/ENGINEER. The default name of a datum axis is
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A_(Number), where Number represents the number of datum axis. However, the default
name of the datum axes can be changed in the same way as that of the datum planes.

When you choose Insert > Model Datum > Axis from the menu bar or the Axis button from
the Datum toolbar, the DATUM AXIS dialog box appears, as shown in Figure 5-27. The
options available in this dialog box are discussed next.

Placement Tab
When you invoke the DATUM AXIS dialog box, the Placement tab is chosen by default.
Under this tab, the References collector allows you to select the references that will create
the datum axis. The constraints are displayed on the right of the references. These constraints
are applied automatically based on the reference you select. The constraints that are used to
create a datum axis are discussed later in this chapter.

The Offset References collector is available only when the Normal constraint is used in the
References collector to define a datum axis. To define the datum axis, you need to select two
references. These references can be an edge, datum plane, face, or axis. The references can
be specified dynamically on the model by dragging the handles displayed on the datum axis.
The handles on the datum axis are displayed only when you select a reference. You can also
select the references using the DATUM AXIS dialog box.

There are three drag handles that are available on the model, as shown in Figure 5-28.
The middle handle is used to move the position of the axis you are creating and it
appears like a white square. The other two handles are used to specify the references for
dimensioning and appear like a green square.

Display Tab
The options in this tab are used to control the length of the axis. The DATUM AXIS dialog
box with the Display tab chosen is shown in Figure 5-29. Select the Adjust Outline check box

Figure  5-27  The DATUM AXIS dialog
box with the Placement tab chosen
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to activate the Length edit box. By default, the Length edit box is in the inactive mode. You
need to select the Adjust Outline check box to activate it. You can enter a value in this edit
box or drag the handles displayed at both ends of the datum axis to modify its length.

Properties Tab
The Properties tab of the DATUM AXIS dialog box is shown in Figure 5-30. This tab, when
chosen, allows you to name the datum axis you are creating. By default, the first datum axis
you create is named A_1 and then additional datum axis created are successively named. As
mentioned earlier, a datum axis is created using constraints which are applied automatically,
and filters available in the Filter drop-down list located in the Status Bar. While creating a
datum axis, the filters that are available in the Filter drop-down list are shown in Figure 5-31.
The constraints that are used to create a datum axis are discussed next.

Figure 5-28  Solid model with the datum axis and three drag handles

Figure 5-29  The DATUM AXIS dialog
box with the Display tab chosen
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Datum Axis Passing Through an Edge
The Through constraint is used to create a datum axis passing through any selected edge.
This constraint will be displayed in the dialog box when you select an edge, as shown in
Figure 5-32. In Figure 5-32, A_1 is the datum axis created using this option.

Note
While creating a datum axis, you may need to create datum points in order to create the datum
axis passing through them. Therefore, in the various cases that are discussed next you may need
to create datum points. Datum points are discussed later in this chapter.

Datum Axis Normal to a Plane
The Normal constraint is used to create a datum axis normal to a selected face or datum
plane. When you select a face or a datum plane, the Normal constraint will be displayed in
the dialog box and you are prompted to select two references to place the axis. Notice that
three drag handles appear on the model. Use the middle handle to change the location of
the axis on the selected face. After you specify its placement location, you need to select two
edges, axes, datums, or faces to specify the linear dimension for the placement of the datum
axis. Click in the Offset References collector. The collector turns yellow in color. When you
select the first edge for the placement dimensions of the axis, the offset value will be
displayed in the Offset References collector. You can accept the default dimension or click
on it to change its value. Similarly, select the second edge for dimensioning by pressing
CTRL+left mouse button and enter the dimension value. In Figure 5-33, the preview of the
datum axis with drag handles is shown. It should be noted that the references for
dimensioning can also be selected dynamically using these drag handles.

Note
When you select a reference for creating the datum axis and you are prompted to select the
placement references, you need to click in the Offset References collector to make it yellow in
color. The yellow color of this area in the DATUM AXIS dialog box indicates that now you can
select the references to place the axis. Until the Offset References collector is made yellow in
color, you will not be able to select the placement references.

Figure 5-30  The DATUM AXIS dialog
box with the Properties tab chosen

Figure 5-31  Filters available in
the Filters drop-down list
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Datum Axis Passing Through a Datum Point and Normal to a Plane
The Normal constraint creates a datum axis passing through a datum point or vertex and
normal to any face or datum plane. When you select a face or a datum plane to which the
datum axis will be normal, you are prompted to select two references to place the axis. Use
CTRL+left mouse button to select the datum point or vertex to create an axis passing through
it. Choose the OK button to exit the DATUM AXIS dialog box. In Figure 5-34, the preview
of the datum axis and the datum point is shown.

Datum Axis Passing Through the Center of a Round Surface
The Through constraint is used to create a datum axis passing through the center of a
cylindrical or round surface. To create this datum axis, select the round surface through
which you need to pass the datum axis. The axis is automatically created and it passes through
the center. In Figure 5-35, the preview of the datum axis is shown. The selected cylindrical
surface is highlighted in this figure.

Figure 5-33  Datum axis created normal to the
plane

Figure 5-32  Datum axis created along the edge

Figure 5-35  Datum axis passing through the
center of a cylinder

Figure 5-34  Datum axis passing through the
datum point and normal to the plane
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Datum Axis Passing Through the Edge Formed by Two Planes
The Through constraint is used to create a datum axis passing through the intersection edge
of two planar faces or planes. When you select the face, the Normal constraint is applied
automatically. Click on it to open the drop-down list and select the Through constraint. Now,
select the second face using the CTRL+left mouse button. A datum axis is created passing
through the edge formed by the two faces or planes. In Figure 5-36, the preview of the datum
axis is shown. The two faces that were selected are also highlighted in this figure.

Datum Axis Passing Through Two Datum Points or Vertices
The Through constraint is used to create a datum axis between two datum points or vertices.
To create this datum axis, select the first vertex and then using CTRL+left mouse button,
select the second vertex. The datum axis is created along the two selected datum points or
vertices. In Figure 5-37, the preview of the datum axis is shown with the two vertices
highlighted.

Datum Axis Tangent to a Curve and Passing Through its Vertex
The Tangent and Through constraints create a datum axis tangent to a curve and passing
through one of its vertex. Select the edge of the cylindrical surface as the first selection. Make
sure you do not select the cylindrical surface. After you select a curve or an edge, use CTRL+left
mouse button to select one vertex of the edge. The datum axis is created tangent to the curve
and passing through its selected vertex. In Figure 5-38, the preview of the datum axis that is
created using the Tangent and Through constraints is shown. The curved edge is also
highlighted in this figure.

Datum Points
Datum points are imaginary points created in Pro/ENGINEER to aid in creating
models, drawings, analyzing models, and so on. The uses of datum points are
as follows:

1. To create datum planes and axes.

Figure 5-36  Datum axis created on the edge
where the two selected planes meet
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2. To associate note in the drawings and attach datum targets.

3. To create coordinate system.

4. To specify point loads for mesh generation.

5. To create pipe features.

The default name associated with a datum point in Pro/ENGINEER is PNT(Number) where
Number indicates the number of datum points created in a particular model. However, you
can change the default name associated with the datum points.

When you choose Insert > Model Datum > Point from the menu bar or the Point button from
the Datum toolbar, the DATUM POINT dialog box is displayed with various options to create
datum points, as shown in Figure 5-39. This dialog box can be used to create more than one
datum point. The options in the DATUM POINT dialog box are discussed next.

Placement Tab
The Placement tab in the DATUM POINT dialog box has the options that change with the
reference selected. However, the References display box shown in Figure 5-39 is always present.
This area is used to select the references which aid in placing the datum point. The
constraints available in the drop-down list in the References collector depend on the
references you select from the model. This means that the references narrow down the type
of constraints you can apply on the datum point that you are creating.

Figure 5-38  Datum axis created tangent to the
selected curve

Figure 5-37  Datum axis created between the
two selected vertices

Tip: While creating a datum feature, the references selected from the model help you
to choose from the available constraints that you can apply to constrain the datum
feature. References reduce the range of available constraints, thus reducing the time
taken in selecting the appropriate constraint. For example, the lesser the number of
options available for a person, the lesser the time he needs to decide among them.
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Various cases of creating datum points are discussed next.

Datum Point on a Face or a Datum Plane
The On constraint is used to create datum points on a face or a datum plane. When you
select a face or a datum plane to place the datum point, a yellow colored point will be displayed
at the selected location on the surface with the three drag handles, as shown in Figure 5-40.

Next, click in the Offset References collector to make it yellow in color. You are prompted to
select two references to specify the linear dimensions for the placement of the datum point.
Note that the second selection to select the reference should be made by using CTRL+left
mouse button. After you select the two planes or edges for the placement of dimension of the
point, a default value will be displayed in the Offset References collector. You can accept the
default value or change it to the required value. After the datum point is located at the
desired position on the face or datum plane, choose the OK button to exit the dialog box.

Figure 5-40  Datum point on a face and the three drag handles

Figure 5-39  The DATUM POINT dialog box
with the Placement tab chosen
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Datum Point Offset to a Face or a Datum Plane
The Offset constraint creates datum points at an offset distance from a specified face or a datum
plane in a specified direction. Select a face or a datum plane from where the offset distance for
the placement of the datum point will be measured. The On constraint is applied automatically.
From the drop-down list in the References collector, change the constraint to Offset. The model
and the DATUM POINT dialog box appear, as shown in Figures 5-41 and 5-42.

In the Offset edit box under the References collector, enter the offset value. You will be
prompted to select the planes or the edges for dimensioning the point. Select two planes or
edges for dimensioning and enter the distances from the highlighted references.

You can also specify the offset distance dynamically by using the middle drag handle. The
two references for dimensioning the datum point can be specified by using the drag handles
or selecting directly on the model.

Note
When you use the Offset constraint, the middle drag handle is used to specify the offset distance
and when you use the On constraint, it is used to specify the location of the datum point on the
selected face.

Datum Point at the Intersection of Three Surfaces
The On constraint is used to create a datum point at the intersection of three surfaces. To
create this datum point, select the three surfaces; datum point will be created, as shown in
Figure 5-43.

The datum point is created on the vertex that is common to the three surfaces. Remember
that the first reference is selected using the left mouse button. The second and third
references are selected using CTRL+left mouse button. After selecting the three surfaces,
the DATUM POINT dialog box is displayed, as shown in Figure 5-44.

Figure 5-42  The DATUM POINT dialog box
with Offset constraint selected

Figure 5-41  Datum point on the top face with
offset 0 and the three drag handles
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It might so happen that with the current selection of references, more than one intersection
point exist. In such a case, use the Next Intersection button in the DATUM POINT dialog
box to select the other intersection points to create the datum point on them.

Datum Point on a Vertex
The On constraint is used to create a datum point on the vertex of a face, an edge, or a datum
curve. Invoke the DATUM POINT dialog box and then select a vertex to create the datum
point. Choose the OK button to exit the dialog box.

Note
You can create more than one datum point by simply selecting the desired vertex.

Figure 5-44  The DATUM POINT dialog box

Figure 5-43  The three highlighted surfaces and the datum point
at the intersection of the three surfaces
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Datum Point at the Center of a Curved Edge
The Center constraint creates a datum point at the center of an arc or a curved edge. Invoke
the DATUM POINT dialog box and select the curve edge. The On constraint is applied
by default. To modify the constraint, select the constraint in the References collector; the
drop-down list appears to the right of the constraint. Choose the Center constraint from it to
create the datum point at the center of the curved edge.

Datum Point on an Edge or a Curve
The On constraint is used to create a datum point on an edge or a curve. Invoke the DATUM
POINT dialog box, and select an edge or a curve. The datum point is placed on the selected
edge, as shown in Figure 5-45 and the DATUM POINT dialog box appears, as shown in
Figure 5-46.

In the DATUM POINT dialog box, after the point is placed, the dimension type can be
defined. The Offset dimension box displays the offset distance of the datum point from one
end of the edge. The offset distance is measured as a ratio or as a real value from the end of
the edge, which can be selected from the drop-down list, as shown in Figure 5-46.

In the Offset References area, the Next End button is used to flip the end of the edge from
where the offset distance is measured. This button is available only when the End of curve
radio button is selected. If you select the Reference radio button, you need to select a
reference from which the datum point will be dimensioned.

Sketched Datum Point Button
When you choose the black arrow on the right of the Point button, a flyout will be
displayed. Choose the Sketched button from this flyout; the Sketch Datum Point
dialog box will be displayed. The function of this dialog box is same as the Sketch

dialog box. Using the Sketch Datum Point dialog box, select the sketching plane and its

Figure 5-45  The highlighted edge and the datum
point at some offset distance from one end of edge

Figure 5-46  The DATUM POINT dialog box
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orientation. When you choose the Sketch button, the system takes you to the sketcher
environment. In the sketcher environment, you can use the construction tools and the Point
button to sketch the datum points. The datum points are dimensioned with the references.
You can also modify these dimensions. Remember that you can exit the sketcher environment
only if at least one point is drawn.

To Create an Array of Datum Points from a Coordinate System
The Offset Coordinate System button is used to create an array of datum points at
an offset distance from a coordinate system. You can change the array of the points
by redefining the array. This button is available on the flyout. Note that the Datum

Coordinate system must be defined before you create an array of datum points.

When you choose this button, the Offset CSys Datum Point dialog box will be displayed, as
shown in Figure 5-47  and you are prompted to select a coordinate system. After selecting
a coordinate system, you can enter the values of the coordinates for the datum points.

To add a point, click under the Name column in the list box; the first row gets activated.
Click under the XAxis column; the edit box appears in which you can enter an offset
value. Similarly, enter the offset values for Y and ZAxis. To add another point click in the
next row. From the Type drop-down list, select the type of coordinate system: Cartesian,
Cylindrical, or Spherical. In Figure 5-47, the coordinates of three datum points are entered
in the Offset CSys Datum Point dialog box.

Figure 5-47  The Offset CSys Datum Point dialog box
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To Create a Datum Point by Clicking
When you choose the Field button from the flyout, the Field Datum Point dialog box
will be displayed, as shown in Figure 5-48. Using this dialog box, you can create a
datum point anywhere on the surface of the model. You just need to specify the

location using the left mouse button to place a datum point.

CREATING CUTS
Cut is a material removal process and this option is available only when at least one
base feature exists in the drawing area. The Remove Material  button available on
the dashboard of the feature creation tools is used to create the cuts. In this chapter,

you will learn the extrude cut and the revolve cut. The procedure to create a cut on an
existing feature is similar to that of adding material or protrusion.

Removing Material by Extruding a Sketch
The Extrude Cut is an extruded feature that is created by removing material from an existing
feature. The material that is removed is defined by a sketch.

After drawing the sketch for the cut feature, you can specify the direction of material removal
with respect to the sketch. For example, the yellow arrow in Figure 5-49 shows the direction
of material removal. If the direction shown by the arrow is accepted, then the cut feature will
be created, as shown in Figure 5-50.

However, if you choose the Change material direction of extrude to other side of sketch
button from the Extrude dashboard, the arrow points in the direction shown in Figure 5-51.
Entire material on the plane selected for sketching will be removed, leaving the extruded cut
feature, as shown in Figure 5-52.

Note
A straight hole can also be created by drawing its cross-section, that is a circle, and then
creating an extrude cut. But, Pro/ENGINEER provides predefined placement for a hole feature,
which can be more desirable than dimensioning the cross-section of a cut feature. Straight
holes do not require a sketch if you use the Hole dashboard. The Hole dashboard is discussed
in Chapter 6.

Figure 5-48  The Field Datum
Point dialog box
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Removing Material by Revolving a Sketch
The Revolve Cut is a revolved feature that is created by removing material from an existing
feature. The material that is removed is defined by the sketch you draw. Remember that the
center line is necessary in a revolve features. Figure 5-53 shows the section drawn that is to be
revolved. The front surface of the second extruded feature is selected as the sketching plane.
Figure 5-54 shows the revolve cut created on the selected surface.

Note
The Sweep Cut is explained in Chapter 8.

Tip: In the model shown in Figure 5-49, the sketching plane selected for creation of
the extruded cut is not a datum plane but the front face of the base feature. You can
also create a datum plane on the surface of an existing feature and select it as the
sketching plane. But it is not recommended to create a datum plane if a planar
surface of the feature can be used as a sketching plane.

Figure 5-50  Cut feature created on the selected
plane

Figure 5-49  Sketch for the extrude cut and
arrow showing the direction of material removal

Figure 5-52  Cut feature created in the direction
shown in the adjacent figure

Figure 5-51  Arrow showing the direction of
material removal
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TUTORIALS

In this tutorial, you will create the model shown in Figure 5-55. The front and the
right-side views of the solid model are shown in Figure 5-56.   (Expected time: 30 min)

The following steps are required to complete this tutorial:

a. Examine the model and determine the number of features in it, refer to Figure 5-55.
b. Create the base feature, refer to Figures 5-57 and 5-58.
c. Create the second extrude feature that is at the bottom of the base feature, refer to

Figures 5-59 through 5-62.
d. Create the third feature on an offset plane, refer to Figures 5-63 through 5-68.
e. Create the circular cut feature, refer to Figures 5-69 through 5-72.

Figure 5-54  Revolve cut createdFigure 5-53  The section for revolve cut

Tutorial 1

Figure 5-55  Model for Tutorial 1
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Figure 5-56  Front and side views of the model

Setting the Working Directory
When Pro/ENGINEER session is started, the first task is to set the working directory. A
working directory is a directory on your system where you can save the work done in the
current session of Pro/ENGINEER. You can set any existing directory on your system as
the working directory.

1. Choose the Set Working Directory option from the File menu; the Select Working
Directory dialog box is displayed. Select C:\ProE-WF-4.0 folder.

2. Choose the Organize tab from the Select Working Directory dialog box to display the
flyout. Next, choose the New Folder option from the flyout; the New Folder dialog box
is displayed.

3. Enter c05 in the New Directory edit box and choose OK from the dialog box. You have
created a folder named c05 in C:\ProE-WF-4.0.

4. Next, choose OK from the Select Working Directory dialog box. The working directory
is set to C:\ProE-WF-4.0\c05. A message Successfully changed to C:\ProE-WF-4.0\c05
directory is displayed in the message area.

Starting a New Object File
1. Open a new part file and name it as c05tut1. The three default datum planes are displayed

in the drawing area. The Model Tree also appears on the left in the Navigator. Close the
Model Tree by clicking on the sash on its right edge.

Selecting the Sketching Plane for the Base Feature
To create the sketch for the base feature, you need to first select the sketching plane. In
this model, you need to draw the base feature on the FRONT datum plane because from
the isometric view of this model, it is evident that the direction of extrusion for this
feature is perpendicular to the FRONT datum plane.
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Note
The model can be created by selecting any plane as the sketching plane for the base feature. But
when the base feature is created, the orientation of the base feature will not be proper. Hence, the
final model will be oriented in the wrong direction. You will have to be careful while defining the
sketching plane for the base feature. The desired orientation of the model is shown in Figure 5-55.

1. Choose the Extrude button from the Base Features toolbar; the Extrude dashboard is
displayed above the graphics window.

2. Choose the Placement tab and from the slide-down panel, choose the Define button; the
Sketch dialog box is displayed.

3. Select the FRONT datum plane as the sketching plane.

A yellow arrow is displayed on the FRONT datum plane, pointing in the direction of
viewing the sketch.

4. Select the TOP datum plane from the drawing area and then select the Top option from
the Orientation drop-down list.

The TOP datum plane is selected in order to orient the sketching plane.

5. Choose the Sketch button from the Sketch dialog box. Now, you enter the sketcher
environment.

Creating and Dimensioning the Sketch for the Base Feature
The base feature can be created by drawing the sketch and then extruding it to the given
distance.

1. Draw the sketch using various sketcher tools and add the required constraints and
dimensions shown in Figure 5-57. When you initially draw the sketch, it is
dimensioned automatically and some weak dimensions are assigned to it.

2. Modify the dimension values to those shown in Figure 5-57.

3. After the sketch is completed, choose the Done button.  Now, you are out of the sketcher
environment.

4. Choose the Named View List button from the View toolbar; the flyout is displayed.
Choose the Default Orientation option from the flyout; the model orients in its default
orientation, that is, trimetric view, as shown in Figure 5-58. The yellow colored arrow is
displayed on the model, indicating the direction of extrusion.

Tip: It is recommended that you use the Modify button to modify the weak
dimensions. In the Modify Dimensions dialog box that appears, clear the
Regenerate check box and then modify the dimensions using the thumbwheel or the
dimension edit box. This way the sketch will not regenerate as you edit dimensions.
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5. In the dimension box present on the Extrude dashboard, enter the value 8, the model
appears, as shown in Figure 5-58.

6. Choose the Build feature button from the Extrude dashboard. The base feature is
completed. You can use the middle mouse button to spin the model in order to view it
from various directions.

Note
When you choose the Default Orientation option from the Named View List button, the
orientation of the model is trimetric and not isometric. If you want the isometric view of the
model to be displayed whenever you choose the Default option, then you have to use the
Environment dialog box. The Environment dialog box is displayed when you choose Tools >
Environment from the menu bar. From the dialog box, in the Standard Orient
drop-down list, choose the Isometric option. Now, the default orientation will be set to isometric.

Selecting the Sketching Plane for the Second Feature
The second feature is an extrude feature and will be created on the previous plane that
was used to create the base feature.

1. Choose the Extrude button from the Base Features toolbar; the Extrude dashboard is
displayed above the drawing area.

2. Choose the Placement tab and from the slide-down panel, choose the Define button; the
Sketch dialog box is displayed.

Figure 5-58  Default orientation of the model and
the arrow showing the direction of feature creation

Figure 5-57  Sketch for the base feature with
dimensions and constraints

Tip: It is recommended to check the orientation of the base feature of a model when it
is completed. To check whether the plane you specified for sketching was correct or
not, choose the Named View List button from the View toolbar a flyout is displayed.
Next, choose the FRONT option from the flyout; the base feature will reorient in the
drawing area such that you can view the front view of the base feature.
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3. Choose the Use Previous button from the Sketch Plane area in the Sketch dialog box;
the sketcher environment is activated automatically.

When you choose the Use Previous button, the system selects the previous sketching
plane that was used to create the base feature. This option is selected because the base
feature and the second feature are on the same plane, but have different depths of
extrusion. If they had the same depth of extrusion, you could have drawn them on the
same plane as a single feature. The TOP datum plane and its orientation is set
automatically.

Drawing the Sketch for the Second Feature
The second feature has a rectangular section that will be extruded to a depth of
14. To improve the clarity of the edges of the base feature, choose the No
hidden button from the Model Display toolbar before you start sketching the
second feature.

1. Draw the sketch, as shown in Figure 5-59.

2. The sketch is automatically constrained and some weak dimensions are assigned to it.
Add the required constraints and modify the weak dimensions, as shown in Figure 5-59.

3. Choose the Done button to exit the sketcher environment. The Extrude dashboard
is enabled above the drawing area. Choose the Shading button from the Model
Display toolbar to view the shaded model.

4. Use the middle mouse button to orient the model, as shown in Figure 5-60. This
orientation of the model gives you a better view of the sketch in the three-dimensional

Tip: You can use the Use button from the Sketcher Tools toolbar to use the bottom
edge of the base feature. The edge of the base feature is required to complete the sketch
for the second feature. Or else, draw an aligned line on the edge.

Figure 5-59  Sketch for the second feature



5-34                Pro/ENGINEER Wildfire for Designers

FFFF F o
r 

de
ta

il
s 

a
bo

ut
 O

nl
in

e
 t

ra
in

in
g 

in
 P

o
r 

de
ta

il
s 

a
bo

ut
 O

nl
in

e
 t

ra
in

in
g 

in
 P

o
r 

de
ta

il
s 

a
bo

ut
 O

nl
in

e
 t

ra
in

in
g 

in
 P

o
r 

de
ta

il
s 

a
bo

ut
 O

nl
in

e
 t

ra
in

in
g 

in
 P

o
r 

de
ta

il
s 

a
bo

ut
 O

nl
in

e
 t

ra
in

in
g 

in
 P

o
r/

E
N

G
IN

E
E

R
 W

il
df

ir
e

 4
.0

o
r/

E
N

G
IN

E
E

R
 W

il
df

ir
e

 4
.0

o
r/

E
N

G
IN

E
E

R
 W

il
df

ir
e

 4
.0

o
r/

E
N

G
IN

E
E

R
 W

il
df

ir
e

 4
.0

o
r/

E
N

G
IN

E
E

R
 W

il
df

ir
e

 4
.0

vi
si

t 
w

w
w

vi
si

t 
w

w
w

vi
si

t 
w

w
w

vi
si

t 
w

w
w

vi
si

t 
w

w
w

.c
a

dc
im

.c
o

m
.c

a
dc

im
.c

o
m

.c
a

dc
im

.c
o

m
.c

a
dc

im
.c

o
m

.c
a

dc
im

.c
o

m

(3D) space. The yellow colored arrow is also displayed on the model, indicating the
direction of extrusion.

5. Enter the value 14 in the dimension box present on the Extrude dashboard and press
ENTER. The second extruded feature is completed and its preview is displayed in the
drawing area.

6. Choose the Named View List button from the View toolbar; the flyout is displayed.
Choose the Default Orientation option from the flyout; the model orients in its default
orientation, that is, trimetric view.

7. Now, choose the Build feature button from the Extrude dashboard to confirm the
feature creation. The model orients on the screen, as shown in Figure 5-61. You can also
use the middle mouse button to spin the model.

Creating the Datum Plane for the Third Feature
A new datum plane is required to create the next feature. The datum plane will be
created at an offset distance of 2 from the front face of the second feature. You need to
turn on the display of datum planes if their display is off.

1. Choose the Plane button from the Datum toolbar; the DATUM PLANE dialog box is
displayed.

Make sure that before opening the dialog box, no selections are made. This can be
confirmed from the Status Bar that is available below the drawing area. If there is a
selection, you can remove it by left-clicking in the empty space of the drawing area.

2. Using the left mouse button, select the front face of the second feature highlighted in
Figure 5-62. The boundary of the selected front face is highlighted in red color.

In the DATUM PLANE dialog box, under the References collector, the Offset

Figure 5-61  Second extruded feature with the base
feature

Figure 5-60  Arrow showing the direction of
feature depth
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constraint is displayed. This means that by the smart selection property of
Pro/ENGINEER Wildfire 4.0, the Offset constraint is applied automatically to the
datum plane you are going to create.

Now, you need to specify the offset distance. If you enter a positive value, the datum plane
will be created in the direction shown by the arrow and if you enter a negative value then the
datum plane will be created in the direction opposite to that shown by the arrow.

3. In the Translation dimension box, under the Offset area of DATUM PLANE dialog
box, enter the value -2 and press ENTER.

The negative value is entered because the datum plane has to be created in the direction
opposite to that shown by the yellow arrow.

4. Choose the OK button. The datum plane named DTM1 is created, as shown in Figure 5-63.

Creating the Third Feature on DTM1
The datum plane DTM1 is created and can be seen in the Model Tree as well as in the
drawing area. The sketch of the next feature that will be extruded has to be created on
the datum plane DTM1.

1. Choose the Extrude button from the Base Features toolbar; the Extrude dashboard is
displayed above the drawing area.

2. Choose the Placement tab and from the slide-down panel, choose the Define button; the
Sketch dialog box is displayed.

3. Select DTM1 as the sketching plane for the third feature. A yellow arrow is displayed on
the selected datum plane, as shown in Figure 5-64. This arrow shows the direction of
viewing the sketching plane.

The TOP datum plane and its orientation is selected by default.

Figure 5-63  The highlighted datum planeFigure 5-62  The selected face and the arrow
showing the positive direction of datum plane
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4. Choose the Sketch button from the Sketch dialog box. The system takes you to the
sketcher environment. Choose the No hidden button from the Model Display toolbar.

5. Sketch the section for the third feature of the model and add constraints and dimensions
to the sketch, as shown in Figure 5-65.

6. Choose the Done button to exit the sketcher environment.

The Extrude dashboard is enabled above the drawing area. Turn the model display to
Shading. Use the middle mouse button to orient the model, as shown in Figure 5-66.
This orientation gives a better view of the model.

Notice that the yellow arrow is pointing toward the direction of feature creation. But, you
need to extrude the sketch in the opposite direction.

8. Choose the Change depth direction of extrude to other side of sketch button
from the Extrude dashboard to change the direction of arrow.

9. Enter a value of 10 in the dimension box present on the Extrude dashboard. The
preview of the third feature is displayed in the drawing area.

10. Now, choose the Build feature button from the Extrude dashboard to confirm the feature
creation.

Choose the Named View List button from the View toolbar; the flyout is displayed.
Choose the Default Orientation option from the flyout; the model orients in its default
orientation, that is, trimetric view, as shown in Figure 5-67.

Selecting the Sketching Plane for the Cut Feature
A through cut will be created on the outer right face of the third feature. The circular
section for the cut will be sketched and using the Remove Material button in the

Figure 5-65  Sketch with dimensions and constraints
of the third feature

Figure 5-64  Arrow on DTM1 showing the
direction of viewing the sketching plane
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Extrude dashboard, the circular cut will be created. The sketching plane for the cut
feature is shown in Figure 5-68.

Note
The circular cut feature can also be created using the Hole tool, which will be discussed in
Chapter 6.

1. Choose the Extrude button from the Base Features toolbar. The Extrude dashboard is
displayed above the drawing area.

2. Choose the Remove Material button from the Extrude dashboard.

3. Choose the Placement tab, and from the slide-down panel choose the Define button; the
Sketch dialog box is displayed.

4. Select the face shown in Figure 5-68 for sketching.

5. Using the left mouse button, select the TOP default datum plane and then select the
Top option from the Orientation drop-down list.

6. Choose the Sketch button; the system takes you to the sketcher environment.

Sketching the Cut Feature
1. Turn the model display to No hidden. Draw the sketch of the cut feature and add

dimensions to it, as shown in Figure 5-69.

2. Choose the Done button and turn the model display to Shading.

3. Choose the Named View List button from the View toolbar; the flyout is displayed.
Choose the Default Orientation option from the flyout; the model orients in its default
orientation, that is, trimetric view, as shown in Figure 5-70. Two yellow arrows also appear
on the model. One arrow indicates the direction of feature creation and the other arrow

Figure 5-67  Model after creating the third featureFigure 5-66  Arrow showing the direction of
material addition
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indicates the direction with respect to the sketch from where the material will be
removed. Figure 5-70 shows the direction where the arrows are pointing.

4. Choose the Options tab in the Extrude dashboard; the Depth slide-down panel is
displayed.

5. From the Side 1 drop-down list, choose the Through All option. The cut feature is
completed and can now be previewed in the drawing area.

6. Choose the Build feature button from the Extrude dashboard. Turn the model display
to shaded by choosing the Shading button from the Model Display toolbar. The
trimetric view of the model is shown in Figure 5-71.

Saving the Model
1. Choose the Save button from the File toolbar and save the model.

The order of feature creation can be seen from the Model Tree shown in Figure 5-72.

Figure 5-70  The two arrows on the cut feature

Figure 5-69  Sketch and dimensions for cutFigure 5-68  Sketching plane for the hole feature
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In this tutorial, you will create the model shown in Figure 5-73. This figure also shows the
front, top, and right-side views of the solid model.     (Expected time: 45 min)

Tutorial 2

Figure 5-73  Top, front, right-side, and isometric views of the model

Figure 5-72  Model Tree for Tutorial 1Figure 5-71  Completed model for Tutorial 1
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The following steps are required to complete this tutorial:

a. Examine the model and determine the number of features in it, refer to Figure 5-73.
b. Create the base feature, refer to Figures 5-74 and 5-75.
c. Create the second feature on the left face of the base feature, refer to Figures 5-76

through 5-80.
d. Create the third and fourth features on the same plane, but with different extrusion

depths, refer to Figures 5-81 through 5-88.

After understanding the procedure for creating the model, you are now ready to create
it. Set the working directory, if required.

Starting a New Object File
1. Start a new part file and name it as c05tut2. The three default datum planes are displayed

in the drawing area.

Selecting the Sketching Plane for the Base Feature
To create the sketch for the base feature, you need to first select the sketching plane for
the base feature. In this model, you need to draw the base feature on the TOP datum
plane. This is because the direction of extrusion of the base feature is perpendicular to
the TOP datum plane.

1. Choose the Extrude button from the Base Features toolbar; the Extrude dashboard is
displayed above the drawing area.

2. Choose the Placement tab and from the slide-down panel choose the Define button; the
Sketch dialog box is displayed.

3. Select the TOP datum plane as the sketching plane; a yellow arrow is displayed on the
TOP datum plane, pointing in the direction of viewing the sketch. The RIGHT datum
plane and its orientation is selected automatically.

4. Choose the Sketch button in the Sketch dialog box to enter the sketcher environment.

Creating and Dimensioning the Sketch for the Base Feature
The sketch for the base feature consists of a rectangular shape with a slot, as shown in
Figure 5-74. When this sketch is extruded, it will create the base feature with the slot, as
shown in Figure 5-75.

1. Draw the sketch using various sketcher tools and add the required constraints and
dimensions to it. Modify these dimensions, as shown in Figure 5-74.

2. Choose the Done button to exit the sketcher environment.

3. Choose the Named View List button from the View toolbar; the flyout is displayed.
Choose the Default Orientation option from the flyout; the model orients in its default
orientation, that is, trimetric view.
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The default view of the model is displayed, but it does not fit on the screen. You may
need to zoom for displaying the model properly in the drawing area. This gives you a
better view of the sketch in the 3D space. A yellow arrow is also displayed on the model,
indicating the direction of extrusion.

4. Enter a value of 16 in the dimension box present on the Extrude dashboard. The
preview of the base feature is displayed in the drawing area.

5. Choose the Build feature button from the Extrude dashboard. The base feature is
completed and is shown in Figure 5-75. You can use the middle mouse button to spin the
object to view it from various directions.

Selecting the Sketching Plane for the Second Feature
The next feature is an extruded feature and will be created on the left face of the base
feature. Therefore, you need to select the left face of the base feature as the sketching
plane and then draw the sketch.

1. Choose the Extrude button from the Base Features toolbar; the Extrude dashboard is
displayed below the drawing area.

2. Choose the Placement tab and from the slide-down panel choose the Define button; the
Sketch dialog box is displayed.

3. Use the middle mouse button to spin the model, as shown in Figure 5-76.

4. Now, select the left face of the base feature as the sketching plane. A yellow arrow that
points in the direction of viewing the sketching plane appears on the left face of the base
feature.

5. Choose the Flip button to flip the yellow arrow and to change the direction of viewing
the sketching plane, refer to Figure 5-76.

Figure 5-75  Base feature of the modelFigure 5-74  Sketch with dimensions and
constraints for the base feature
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6. Select the top face of the base feature shown in Figure 5-77 and choose the Top option
from the Orientation drop-down list.

By selecting the top surface of the base feature, the model will be oriented in such a way
that the highlighted planar surface will be at the top while sketching.

7. Choose the Sketch button from the Sketch dialog box to enter the sketcher environment.

Creating and Dimensioning the Sketch for the Second Feature
The sketch for the second feature consists of two lines and an arc. The bottom edge of
the sketch coincides with the top edge of the base feature. This sketch is extruded to a
depth of 16. Before drawing the sketch, turn the model display to No hidden.

1. Draw the sketch using various sketcher tools, as shown in Figure 5-78. The sketch is
dimensioned automatically and some weak dimensions are assigned to it.

2. Apply the constraints and modify the weak dimensions to the dimensions shown in
Figure 5-78.

3. After the sketch is complete, turn the model display to Shading and choose the Done
button.

The Extrude dashboard is displayed above the drawing area. Use the middle mouse
button to orient the model, as shown in Figure 5-79. A yellow  arrow is also
displayed on the model, indicating the direction of extrusion.

4. Enter the value 16 in the dimension box present in the Extrude dashboard and press
ENTER. The second feature is completed and its preview is displayed on the screen.

5. Choose the Build feature button from the Extrude dashboard. The second feature is
completed and is shown in Figure 5-80. You can use the middle mouse button to spin the
model to view it from various directions.

Figure 5-77  Surface selected to be at the topFigure 5-76  Arrow showing the direction of
viewing the model
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Selecting the Sketching Plane for the Third Feature
The third feature is an extruded feature and will be created on the back planar surface of
the base feature. Therefore, you need to define the back face of the base feature as the
sketching plane and then draw the sketch.

1. Choose the Extrude button from the Base Features toolbar; the Extrude dashboard is
displayed above the drawing area.

2. Choose the Placement tab and from the slide-down panel choose the Define button; the
Sketch dialog box is displayed.

3. Use the middle mouse button to spin the model and then select the face of the base feature shown
in Figure 5-81 as the sketching plane. A yellow arrow is displayed on the selected face.

Figure 5-78  Sketch with dimensions and constraints for the second feature

Figure 5-79  Arrow showing the direction of
material addition

Figure 5-80  Model with the second extruded
feature



5-44                Pro/ENGINEER Wildfire for Designers

FFFF F o
r 

de
ta

il
s 

a
bo

ut
 O

nl
in

e
 t

ra
in

in
g 

in
 P

o
r 

de
ta

il
s 

a
bo

ut
 O

nl
in

e
 t

ra
in

in
g 

in
 P

o
r 

de
ta

il
s 

a
bo

ut
 O

nl
in

e
 t

ra
in

in
g 

in
 P

o
r 

de
ta

il
s 

a
bo

ut
 O

nl
in

e
 t

ra
in

in
g 

in
 P

o
r 

de
ta

il
s 

a
bo

ut
 O

nl
in

e
 t

ra
in

in
g 

in
 P

o
r/

E
N

G
IN

E
E

R
 W

il
df

ir
e

 4
.0

o
r/

E
N

G
IN

E
E

R
 W

il
df

ir
e

 4
.0

o
r/

E
N

G
IN

E
E

R
 W

il
df

ir
e

 4
.0

o
r/

E
N

G
IN

E
E

R
 W

il
df

ir
e

 4
.0

o
r/

E
N

G
IN

E
E

R
 W

il
df

ir
e

 4
.0

vi
si

t 
w

w
w

vi
si

t 
w

w
w

vi
si

t 
w

w
w

vi
si

t 
w

w
w

vi
si

t 
w

w
w

.c
a

dc
im

.c
o

m
.c

a
dc

im
.c

o
m

.c
a

dc
im

.c
o

m
.c

a
dc

im
.c

o
m

.c
a

dc
im

.c
o

m

4. Choose the Flip button to flip the yellow arrow, as shown in Figure 5-81. The arrow
points in the direction of viewing the sketching plane.

5. Select the top face shown in Figure 5-82 and then select the Top option from the
Orientation drop-down list.  Now, the top face of the base feature is selected to be at the
top while drawing the sketch.

6. Choose the Sketch button to enter the sketcher environment.

Creating and Dimensioning the Sketch for the Third Feature
The sketch for the base feature consists of a rectangular section with a semicircular cut at
the top. When this section is extruded, a feature with a semicircular slot will be created.
Turn the display to No hidden.

1. Draw the sketch using various sketcher tools, as shown in Figure 5-83.

2. The sketch is dimensioned automatically and some weak dimensions are assigned to it.
Add the required constraints and modify the weak dimensions to the dimensions shown
in Figure 5-83.

3. Choose the Done button to exit the sketcher environment. The Extrude dashboard is enabled
above the drawing area. Turn the display to Shading.

4. Use the middle mouse button to orient the model, as shown in Figure 5-84. This
orientation of the model gives a better view of the sketch in 3D space. A yellow arrow is
displayed on the model, indicating the direction of extrusion.

5. Enter the value 42 in the dimension box present in the Extrude dashboard and
press ENTER. This feature is completed and its preview can be seen in the drawing
area.

Figure 5-82  Face selected to be at the topFigure 5-81  Arrow showing the direction of
viewing the model
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6. Choose the Build feature button from the Extrude dashboard to confirm the feature
creation. Choose the Named View List button from the View toolbar; a flyout is displayed.
Choose the Default Orientation option from the flyout; the default view of the model is
displayed, as shown in Figure 5-85.

Selecting the Sketching Plane for the Last Feature
The last feature and the third feature are created on the same plane. But the depth of
extrusion is different for both of them. This is the reason they are considered as separate
features. Therefore, for sketching this feature, you can use the sketching plane that was
used for creating the third feature.

1. Choose the Extrude button and then invoke the Sketch dialog box.

2. Choose the Use Previous button from the Sketch Plane area in the Sketch dialog box;
the sketcher environment is activated automatically.

Figure 5-84  Arrow showing the direction of material
addition

Figure 5-83  Sketch with dimensions and
constraints

Figure 5-85  Model with the third extruded
feature
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When you choose the Use Previous button, the system selects the previous sketching
plane that was used to create the base feature.

3. Choose the Sketch button to enter the sketcher environment.

Creating and Dimensioning the Sketch for the Last Feature
The sketch of this feature consists of three lines. The bottom edge of the sketch is aligned
with the top edge of the base feature and the left edge is aligned with the right edge of
the third feature. When this sketch is extruded, it creates a rib shape.

1. Draw the section sketch using various sketcher tools, as shown in Figure 5-86. The sketch
is dimensioned automatically and some weak dimensions are assigned to it. You can add
the required constraints to align the lines and points in the sketch with other features, as
shown in Figure 5-86. In the figure, the constraint symbol displayed on the line indicates
that the edges of the adjacent features are used to close the section.

2. After the sketch is complete, choose the Done button. The Extrude dashboard is enabled.
Use the middle mouse button to orient the model, as shown in Figure 5-87.

3. Enter the value 12 in the dimension box present in the Extrude dashboard. The feature
is completed and its preview can be seen in the drawing area.

4. Choose the Build feature button in the Extrude dashboard.

    The default view of the model is displayed, when you choose the Default Orientation
option from the flyout. To invoke the flyout, choose the Named View List button from
the View toolbar. The default view of the model is shown in Figure 5-88.

Saving the Model
1. Choose the Save button from the File toolbar and save the model. The order of feature

creation can be seen from the Model Tree shown in Figure 5-89.

Figure 5-87  Arrow showing the direction of
material addition

Figure 5-86  Sketch and constraints for the last
feature
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In this tutorial, you will create the model shown in Figure 5-90. This figure also shows the
front, top, and right-side views of the solid model.                          (Expected time: 45 min)

Tutorial 3

Figure 5-90  Top, front, right-side, and isometric views of the model

Figure 5-89  Model Tree for Tutorial 2Figure 5-88  Completed model for Tutorial 2
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    The following steps are required to complete this tutorial:

a. Examine the model and then determine the number of features in it, refer to Figure 5-90.
b. Create the base feature, refer to Figures 5-91 and 5-92.
c. Create the second feature, refer to Figures 5-93 through 5-96.
d. Create the hollow cylindrical feature on an offset datum plane, refer to Figures 5-97

through 5-102.

Starting a New Object File
1. Set the working directory if required and open a new part file with the name c05tut3. The

three default datum planes are displayed in the drawing area if the Plane Display button
is activated.

Selecting the Sketching Plane for the Base Feature
To create the sketch for the base feature, you first need to select the sketching plane. In
this model, you need to draw the base feature on the FRONT datum plane because the
direction of extrusion is perpendicular to the FRONT datum plane.

1. Choose the Extrude button from the Base Features toolbar.

2. Choose the Placement tab and from the slide-down panel choose the Define button; the
Sketch dialog box is displayed.

3. Select the FRONT datum plane as the sketching plane.

A yellow arrow is displayed on the FRONT datum plane and it points in the direction of
viewing the sketch plane. The RIGHT datum plane and its orientation are selected
automatically.

4. Choose the Sketch button to enter the sketcher environment.

Creating and Dimensioning the Sketch for the Base Feature
From the model, the section to be extruded for the base feature is evident. The section
sketch is shown in Figure 5-91. When this sketch is extruded, it will create the base feature.

1. Draw the sketch using various sketcher tools, as shown in Figure 5-91.

2. The sketch is dimensioned automatically and some weak dimensions are assigned to it.
Add the required constraints and modify the weak dimensions, as shown in Figure 5-91.

3. Choose the Done button; the Extrude dashboard is displayed.

4. Choose the Named View List button from the View toolbar; the flyout is displayed.
Choose the Default Orientation option from the flyout; the model orients in its default
orientation, that is, trimetric view and a yellow arrow is also displayed on it, indicating
the direction of extrusion.
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5. Enter the value 60 in the dimension box that is present on the Extrude dashboard and
press ENTER.

6. Choose the Build feature button from the Extrude dashboard.

The base feature is completed, as shown in Figure 5-92. You can use the middle mouse
button to spin the model to view it from various directions.

Selecting the Sketching Plane for the Second Feature
The next feature is an extruded feature. The sketching plane for this feature is the top
face of the base feature.

1. Choose the Extrude button from the Base Features toolbar.

2. Choose the Placement tab; the slide-down panel is displayed. Choose the Define button
from the slide-down panel; the Sketch dialog box is displayed.

3. Select the top face of the base feature shown in Figure 5-93 as the sketching plane. A yellow
arrow that points in the direction of viewing the sketch is displayed on the top face.

4. Choose the Flip button to flip the yellow arrow to point in the direction shown in
Figure 5-93.

5. Select the RIGHT datum plane and then choose the Right option from the Orientation
drop-down list.

6. Choose the Sketch button to enter the sketcher environment.

Creating and Dimensioning the Sketch for the Second Feature
The next feature to be created is an extrude feature. The section for the extrude feature
is shown in Figure 5-94. Before drawing the sketch, turn the model display to No hidden.

Figure 5-92  Base feature of the modelFigure 5-91  Sketch with dimensions and
constraints for the base feature
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1. Draw the sketch using various sketcher tools. In the sketch, draw a center line passing
through the center of the arc, as shown in Figure 5-94. This center line helps in
dimensioning the sketch. Add the required constraints and dimensions to the sketch, as
shown in Figure 5-94. Before exiting the sketcher environment, turn the model display
to Shading.

2. Choose the Done button. The Extrude dashboard is enabled. Use the middle mouse
button to orient the model, as shown in Figure 5-95.

3. Enter the value 10 in the dimension box present on the Extrude dashboard and press ENTER.

4. Now, choose the Build feature button to confirm the feature creation. The default
trimetric view of the extruded feature is shown in Figure 5-96.

Creating a Datum Plane for the Last Feature
To create the hollow cylindrical feature, you require a datum plane. This datum plane

Figure 5-94  Sketch with dimensions and
constraints

Figure 5-93  Arrow pointing from the sketching
plane in the direction of feature creation

Figure 5-95  Arrow showing the direction of
material addition

Figure 5-96  Model with the second extruded
feature
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will be created at an offset distance of 10 from the bottom face of the second feature
shown in Figure 5-97.

Note
The other method to create this feature is to select the top planar surface of the second feature as
the sketching plane and extrude the sketch on both sides of the sketching plane. The depth of
extrusion will be different at both the sides. If you use this method to create this cylindrical
feature, you do not need to create a datum plane.

1. Choose the Plane button from the Datum toolbar; the DATUM PLANE dialog box is
displayed.

2. Spin the model using the middle mouse button and then using the left mouse button,
select the bottom face of the second feature.

As you select the face of the second feature, the Offset constraint is displayed in the
References collector of the dialog box.

3. In the Translation dimension box, enter the value 10.

4. Choose the OK button from the DATUM PLANE dialog box.

Datum plane DTM1 is created, as shown in Figure 5-98 and will be selected as the sketching
plane for creating the sketch.

Selecting the Sketching Plane for the Last Feature
The plane DTM1 will be selected as the sketching plane and the depth of extrusion will
be defined from this plane.

1. Choose the Extrude button from the Base Features toolbar.

2. Choose the Placement tab; the slide-down panel is displayed. Choose the Define
button from the slide-down panel; the Sketch dialog box is displayed.

Figure 5-98  Model after creating the datum planeFigure 5-97  Creating the datum plane
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3. Select DTM1 as the sketching plane. The yellow arrow appears on the datum plane.

4. Choose the Flip button to reverse the direction of viewing the sketch. Now, the arrow
points in the direction shown in Figure 5-99.

5. Select the FRONT datum plane and choose the Bottom option from the Orientation
drop-down list.

6. Choose the Sketch button to enter the sketcher environment.

Creating and Dimensioning the Sketch for the Last Feature
The sketch for the hollow cylindrical feature will be drawn on the datum plane DTM1.
The sketch for the hollow cylindrical feature consists of two concentric circles. Before
drawing the sketch, turn the model display to No hidden.

1. Draw the sketch using various sketcher tools and add the required constraints and
dimensions to it, as shown in Figure 5-100.

2. Choose the Done button; the Extrude dashboard is displayed. Now, turn the model
display to Shading.

Use the middle mouse button to orient the model, as shown in Figure 5-101. This view
gives you a better view of the sketch in the 3D space.

3. Enter the value 60 in the dimension box present on the Extrude dashboard.

4. Choose the Build feature button to confirm the feature creation. The default trimetric
view of the complete model is shown in Figure 5-102.

Saving the Model
1. Choose the Save button from the File toolbar and save the model.

Figure 5-100  Sketch with dimensions and
constraints

Figure 5-99  Direction of viewing the sketching
plane
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Answer the following questions and then compare them to those given at the end of this
chapter:

1. You can change the default names assigned to the datum planes. (T/F)

2. Datum points are also used to associate note in the drawings and attach datum targets.
(T/F)

3. The constraint combination of creating an offset plane through cylinder is a valid
combination. (T/F)

4. Generally, all features in a model are created on a single sketching plane. (T/F)

5. A sketching plane can be selected on the existing face of a feature. (T/F)

6. While creating a datum feature, the ___________ selected from the model helps you
choose from the available constraints that can be applied to constraint the datum feature.

7. Datum axis is an __________ axis that is created in Pro/ENGINEER.

8. The trimetric view of the model is displayed when you choose the __________ option
from the Named View List button.

9. When you create a new object file, __________ default datum planes are displayed in
the drawing area.

10. The default datum planes in the Part mode are named as __________, __________, and
__________.

Figure 5-102  Final model of Tutorial 3Figure 5-101  Preview of the feature

Self-Evaluation Test
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Answer the following questions:

1. Which one of the following is not a type of datum available in Pro/ENGINEER?

(a) Axis (b) Plane
(c) Circle (d) Curve

2. How many methods are available in Pro/ENGINEER to create a datum plane?

(a) One (b) Two
(c) Three (d) Four

3. Which one of the following dialog boxes is displayed when you choose the Point button
from the Datum toolbar while extruding a section sketch?

            (a) DATUM POINT dialog box (b) DATUM PLANE dialog box
(c) DATUM AXIS dialog box (d) None

4. Which one of the following combinations can be used to spin a model in the drawing
area?

(a) CTRL+ALT (b) middle mouse button
(c) left mouse button (d) CTRL+right mouse button

5. Which one of the following menus in the menu bar is used to set the default orientation
of the model to isometric?

(a) File (b) Insert
(c) Tool (d) None

6. Datum planes are considered as feature geometry and have mass and volume. (T/F)

7. To set the default orientation of the model to isometric, you have to use the Environment
dialog box. (T/F)

8. Generally, the sketching plane for the base feature of any model is decided after viewing
the isometric view or the drawing views of the model. (T/F)

9. Datum planes are used as a reference for mirroring features, copying features, for creating
a cross-section, as well as for orientation of references. (T/F)

10. Unlike the datum planes constraint option, all datum axes constraint options are
stand-alone. (T/F)

Review Questions
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mCreate the model shown in Figure 5-103. The dimensions, front view, and right-side view of

the model are shown in Figure 5-104.     (Expected time: 45 min)

Exercises

Exercise 1

Figure 5-104  Front and right-side views of the model

Figure 5-103  Isometric view of the model
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Figure 5-105  Top, front, right-side, and isometric views of the model

Exercise 3

Create the model shown in Figure 5-105. The dimensions, and the front, top, right-side,
and isometric views of the model are also shown in the figure.        (Expected time: 45 min)

Create the model shown in Figure 5-106. The top, front section, and two auxiliary views of
the model are shown in Figure 5-107.       (Expected time: 1 hr)

Exercise 2
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Figure 5-106  The 3D view of the model

Figure 5-107  Top, front section, and two auxiliary views of the model



5-58                Pro/ENGINEER Wildfire for Designers

FFFF F o
r 

de
ta

il
s 

a
bo

ut
 O

nl
in

e
 t

ra
in

in
g 

in
 P

o
r 

de
ta

il
s 

a
bo

ut
 O

nl
in

e
 t

ra
in

in
g 

in
 P

o
r 

de
ta

il
s 

a
bo

ut
 O

nl
in

e
 t

ra
in

in
g 

in
 P

o
r 

de
ta

il
s 

a
bo

ut
 O

nl
in

e
 t

ra
in

in
g 

in
 P

o
r 

de
ta

il
s 

a
bo

ut
 O

nl
in

e
 t

ra
in

in
g 

in
 P

o
r/

E
N

G
IN

E
E

R
 W

il
df

ir
e

 4
.0

o
r/

E
N

G
IN

E
E

R
 W

il
df

ir
e

 4
.0

o
r/

E
N

G
IN

E
E

R
 W

il
df

ir
e

 4
.0

o
r/

E
N

G
IN

E
E

R
 W

il
df

ir
e

 4
.0

o
r/

E
N

G
IN

E
E

R
 W

il
df

ir
e

 4
.0

vi
si

t 
w

w
w

vi
si

t 
w

w
w

vi
si

t 
w

w
w

vi
si

t 
w

w
w

vi
si

t 
w

w
w

.c
a

dc
im

.c
o

m
.c

a
dc

im
.c

o
m

.c
a

dc
im

.c
o

m
.c

a
dc

im
.c

o
m

.c
a

dc
im

.c
o

m

Exercise 4

Hint to create the two side features in Exercise 3:

Feature on the right
1. Create an axis passing through the top face of the base feature and through the RIGHT

datum plane.

2. Create a datum plane passing through the axis (created in the previous step) and at an
angle of 21.5 degrees from the RIGHT datum plane.

3. Now, create an offset plane at a distance of 11 from the datum plane (created in the
previous step). Select this datum plane as the sketching plane.

Feature on the left
1. Create a datum plane passing through the axis of revolution of the base feature and at

an angle of 45 degrees from the FRONT datum plane.

2. Create a datum axis passing through the top face of the base feature and through the
datum plane (created in the previous step).

3. Create a datum plane passing through datum axis (created in the previous step) and at
an angle of 21.5 degrees from the datum plane (created in step1).

4. Create a datum plane offset to a distance of 10 from the datum plane (created in the
previous step).

Create the model shown in Figure 5-108. The dimensions, the left-side view, auxiliary view,
and front view of the model are also shown in the Figure 5-109.           (Expected time: 45 min)
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Figure 5-108  Isometric view of the model

Figure 5-109  Left-side view, auxiliary view, and front view of the model
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Answers to Self-Evaluation Test
1. T, 2. T, 3. T, 4. F, 5. T, 6. geometry, 7. imaginary, 8. Default Orientation, 9. three, 10. TOP,
FRONT, RIGHT.


